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Seneca LOG FACTORY

1. PRELIMINARY INFORMATION

CAUTION!

IN NO CASE MAY SENECA OR ITS SUPPLIERS BE HELD LIABLE FOR ANY INCOMING DATA OR
PROFIT OR LOSSES DUE TO INDIRECT, CONSEQUENTIAL OR INCIDENTAL CAUSES (INCLUDING
NEGLIGENCE) CONNECTED WITH THE USE OR INABILITY TO USE LOG FACTORY, EVEN IF SENECA
WAS INFORMED OF THE POTENTIAL OF THESE DAMAGES.

SENECA, ITS SUBSIDIARIES OR AFFILIATES OR GROUP PARTNERS OR DISTRIBUTORS AND SENECA
DEALERS DO NOT GUARANTEE THAT THE FUNCTIONS FAITHFULLY MEET THE EXPECTATIONS AND
THAT THE SOFTWARE LOG FACTORY, ARE FREE OF ERRORS OR FUNCTION UNINTERRUPTEDLY.

SENECA HAS TAKEN THE UTMOST CARE AND CAUTION IN DRAFTING THIS MANUAL. HOWEVER,
IT MAY CONTAIN ERRORS OR OMISSIONS. SENECA SRL RESERVES THE RIGHT TO MODIFY
AND/OR VARY PARTS OF THIS MANUAL TO CORRECT ERRORS OR TO ADJUST TO PRODUCT
FEATURE CHANGES WITHOUT ANY PRIOR NOTICE.

2. WHAT IS LOG FACTORY?

Log Factory is a Software suite that is composed by Two different software:

1) LogImporter: Automatically acquires “.csv” text log file from:
An FTP server
or

A local/remote directory (also a micro SD card)

and converts it to a database
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2
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. 2 FTP SERVER
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PADOVA_025

ROMA_002

FIRENZE_78

Warning!

Log Importer create One Database for One device (so if you have 10 devices you will get 10 different
database). The database name is the station name label.

Log importer moves (erases) all files from the source (local or ftp server) to the local backup directory.

2) Trend Viewer: Open a database and show you a trend with data for analysis (Trend Viewer)

SQL LITE

Warning!

Log Factory is compatible only with Seneca selected devices.
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Log Factory will create one Database for one device so the Trend Viewer can not display data from 2 or
more different devices at the same time.

3. LOG FACTORY INSTALLATION

Log factory can be installed on Windows 7, Windows 8 or Windows 10 (32 or 64 bits).
If you need to install an FTP server on a windows environment, you can follow this step by step guide:
“FileZilla FTP server Installation manual (Windows OS)” at this address:

http://www.seneca.it/en/linee-di-prodotto/comunicazione-industriale-e-telecontrollo/apparati-gsmgprs-

teleallarmedatalogger/z-gprs3

4. LOG FACTORY FIRST CONFIGURATION

After the installation you need to configure the Log Importer software.
Log importer is launched from seneca/log factory

In the main form we can identify some different areas:

42 Log Importer - 1.0.2.0 A - O x
— © F
file  Tools ~
Source of CSV Files
o =
LOCAL ~ | Directory not selected Configure ...
Separator Device name (f SD source)
| |L|NI(NOWN | [] One subdir Logtofie [ ] Vemose [] Backup on a single file = Channels Setup
TeshvEier EE Conversion Table
Directory not selected Caorfigure...

1] Trend Viewer

Logs /C D \ ks
— 1A

I /

[10:09:43.1134682 - Emor]: INVALID DESTINATION DIRECTORY CANNOQT START K A
[10:09:43.1635542 - Info]: NO UPDATE AVAILABLE

[10:09:43.1164704 - Info]: ENTERING RUNNING STATE

[10:09:43.1164704 - Info]: IDLE

[10:09:48.1324955 - Info]: IDLE

[10:09:53.1357884 - Info]: IDLE

[10:09:58.1330053 - Info]: IDLE

[10:10:03.1534691 - Info]: IDLE

[10:10:08.1650233 - Info]: IDLE v

A: Configuration of the source CSV Text data logs
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B: Destination directory for backup logs and database files
C: Data importer status

D: Progress Bar

E: Importer Log

F: Buttons

G: File and Tools Menu

4.1.File and Tools Menu

With the File menu you can save/load the log importer configuration or check for update of the software.

With the Tools menu you can Reset the Data Importer logs (area E) and launch Log importer at windows

startup automatically.

4.2. Configuration of the source CSV Text data logs

Source of C5Y Files

LOCAL | Dirsctory not selected Configure ...

Separator Device name (f SD source)

|; | |L|NKNO‘.".|'N | [] One subdir logtafile [ ] Verbose [ ] Backup on a single file

Select if you wish to Acquire .csv text File from a LOCAL directory or a FTP server.

Device name: Must be used when you acquire csv logs from a SD card from Seneca
Loggers (in this case the loggers don’t write the station name because the
name is in format Lxxxxxxx.csv).

One subdir: If not flagged acquires csv file only from the root directory
If flagged acquires csv file from root and from the first level directory

Log to file: Saves text log generated from the log importer to a file (not to be confused
with data log from the devices)

Verbose: Add Verbose to log importer log (for debug purpose)
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Backup on a single file: If not flagged copies all files to the /bkp directory. All files will be separted
by a sub directory with the acquisition date

If flagged copies all files to the /bkp directory in one unique .csv

4.2.1. Configure Log importer for Importing log data from a microSD card

For import log data from a microSD card (for example for Z-GPRS3, Z-UMTS, Z-LOGGER3, MYALARM?2 etc...)
you must:

1) Connect the microSD to the PC with an adapter
2) Launch Log Importer, select the microSD source directory
3) Fill the “Device Name” item

Log importer automatically will move all csv files from the microSD to the /bkp directory
Warning!

All files in the microSD card will be deleted (but also moved to the PC /bkp local directory).

5. PLAY BUTTON: IMPORTING LOG CSV TO DATABASES

Now that Log importer is configured you can press the “PLAY” button for start the acquisition process.
The progress bar will indicate the amount of work to be performed.

Now you can minimize the importer, as the files arrive in the source directory/ftp they will be written in the
respective databases in the output folder and then erased from the source.

6. CONFIGURE DIGITAL OR ANALOG TAG IN THE DATABASE

When Data arrives from the csv text files the TAG data type is unknow so, if you want to chart in different
way the analog from the digital tag you must edit the database.

™ Channels Setup
For to do that click on then select the database to edit.

For example a typical database from a Z-LOGGER3 device is:
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Traces settings
Name Description isDigital UdmMm Beginning Scale End Scale Sampling Time ~

R ; g T —

VBAT 0 L] 10000 60

DINT 0 a 10000 60

DINZ 0 ] 10000 60

DIN3 0 L] 10000 60

DIN4 0 a 10000 60

DouT1 0 ] 10000 60

pDouT2 0 L] 10000 60

VAL 0 a 10000 60

AVG1 0 ] 10000 60

MIN1 0 L] 10000 60

MAX1 0 a 10000 60

VALZ 0 L] 10000 60

AVGZ 0 L] 10000 60

MINZ 0 a 10000 60

MAXZ 0 L] 10000 60

WRK1 0 L] 10000 60

TOT1 0 a 10000 60

CNT1 0 L] 10000 60

DELTA1 0 L] 10000 60

WRK2Z 0 a 10000 60 ©

oy |[ Cwed

We know that the tags from “POW” to “DOUT2” are digital so we put isDigital =1 on all the tags:

Traces settings
Name Description isDigital Udm Beginning Scale End Scale Sampling Time [l
POW 1 0 10000 60
VBAT 1 0 10000 60
DIN1 1 0 10000 80
DINZ 1 0 10000 60
DIN3 1 0 10000 60
DINg 1 0 10000 60
DouT1 1 0 10000 60
DouT2 1 0 10000 60
VAL1 o 0 10000 60
AVG1 ) 0 10000 80
MIN1 o 0 10000 60
MAX1 ) 0 10000 60
VALZ o 0 10000 60
AVGZ ) 0 10000 60
MINZ o 0 10000 60
MAX2 o 0 10000 60
WRK1 ) 0 10000 60
TOT1 o 0 10000 60
CNT1 ) 0 10000 60
DELTA1 o 0 10000 60
WRK2 ) 0 10000 60 v
Moy || Cancd

Then click on “Apply”.

All others tags will be viewed like Analog Tags.

7. OPEN AND ANALYZE THE DATABASE IN TREND VIEWER
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Now we are ready to open the database in trend viewer, for to do that click on
button:

o7
o8

03
0z

o T T T T T T T T T T u
30/12/99 000180 2/12009 00:0:00 {12110 000D 2312029 OOIA0 2128 ODIA  LNIZHS 000D  INLHYS DI000 312G OBBEAD 1IN 00:00:00 OBIZMS 00000 84/1299 ODIOR-SN  KO/1208 DOE:DD.

| oy | tnaew |

Now click on File -> Open and select the database that you want to analyze:

68 Z-NET Tand Viewar - B8 %

f
o
o
w
o
o
o
o
o
I

Now you need to select which tag to add:

Use the “+” icon to add a tag then select it from the list (in alphabetical order):

10
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1
sl
1]
=
L

gk H Channel

Now you need to activate the channels:

Pens
== Channel

] VAL1 e

(= w
icon.

You can change the color of the pen by clicking on the

Wy £-c y’fr
i _ Brint

Now click on refresh icon* | & b & . ¥ the selcted tags are charted:

0 ZNET i Viemes
Be Bt Bt Pringeport Took 1

‘e WS

Channel Range Zaro Value BepSale  EndSale

) — ||

Actus Date (1 0ne

il date snd e fange Finel 2ate snd time
ssymy v oewoo 2 || |outa) vl << || < || > || 2> ||| cavzanr  ~ izoso [ | ] pestars

Liogger]_ftp Laglte w2217

No you can zoom IN/OUT for analyze the trend by creating a box with the mouse:
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1f01/17 08:19:00 22/01/17 08:19:00 24/01/17 08:19:00 26/01/17

Date

Restore
To perform a Zoom out and return to the original view press the right mouse button or click on
button.
. . » - ”
For view digital tags you must select “show digital channels”:
Trend Viewer 1 | Mlarm Viewer | Log
Name  [Trend Viewer 1
= Range Zero Value Beg. Scale End Scale
[y — g E 0 wooe] [ .. [+]
Normalization L ¥ 122 z [l 0000] [ .|
= DInG ~ [l 10000] [ .. |
D e
r Orientation Show
(®) Herizonta Max Value
QO Vertical Min Value /
() Show Analog Channel
(@) Show Digital Channel
Actual Date |No One S NES \ \ \ : :
OFF
ON - \
OFF
ON+ \
OFF
16/01/17 08:19:00 18/01/17 08:19:00 20/01/17 08:19:00 22/01/17 08:19:00 24/01/17 08:19:00 26/01/17 08:19:00 28/01/17 08:19:00 30/01/17 08:19:00 01/02/17 08:19:00
Initial date and tir Range Final date and time -
Date Export 1 Export 2
16/01/2017  ~ 08:19:00 | ’V (Custom) v << < > = "DZIDZIZDH ~ | 1709:00 (2 Restore

It's possible to show also data in Histogram mode (for example the totalizer tags).

12
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7.1. Graph normalization

In Trend viewer a chart can be normalized in this way:

~ Graphoptions
(@ Continuos Line () Histogram

MNormalization

{Mothing)

MaxMin Values

Full 5cale
_dCentral Zero
Nothing : No normalization, the trend is centered
Max/Min Values: The max value (100%) is the upper limit of the chart, the min value (0%) is the chart
lower limit.
Full scale: The max value is the full scale variable value
Central Zero: The trend is centered with lower limit = higher limit * (-1)

8. EXPORT TREND DATA TO CSV

With Trend viewer you can select an area in the graph and then export the selected data to a .csv file by
clicking on “Export 1” button.

T

:| Date I Export 1 Expaort 2

Restore

Warning!

The csv file exported is to be used with an external tools, the file can not be imported with Log Factory.

9. PRINT REPORT

When a Trend is visualized on the screen you can print to a printer/PDF with the menu -> Print report.

In Report Setting you can upload a logo and select wich channels to print:

13
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Report Settings bt
Elements Selected Channels
WAL1
[ Graph vAL2
[ Walues Table
[ Marms Table
Graph Type Time Limit Selected
] Continuos Line Start 16/19/2017 81300 2 Gizrzs
Ot gy w5
Header

W o =

owor

] :
v
Ctrl + ENTER to insert new row

10. LOGIMPORTER CONVERSION TABLE

Log importer can be configured for manage text string into the csv files. For todo that click on button:

EE Conversion Table

Token value convert table

Token String String Value
I —
PUK?! -130
DENY! -130
UNKNOW -130
ERR!! 0
EXCO1 0
EXC02 0
EXCO3 0
FAIL 0
NOANSW 0
UNDEF 0

In this table you can see that a Modbus communication error (NOANSW) for example is converter to a

value of “0”.

14
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If you need to change these values (for example you can set NOANSW to 9999999999 so in trend viewer
you’ll see the communication error with an out of scale value) you can change the default table value.
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